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Accounting Integration with QuickBooks Installation 
and Setup Guide

About Accounting Integration

ManageSM is equipped to integrate with QuickBooks to provide accounting information and 
tools for your shop. 
Before you begin the integration process described in Chapter 6: Accounting Setup and 
QuickBooks Integration, complete the tasks outlined in:

• “Chapter 3: Installing QuickBooks” on page 11 

• “Chapter 4: Setting Up Manage and QuickBooks Prior to Integration” on page 12

• “Chapter 5: Reconciling Accounts and Reports” on page 18

Customer information from Manage is transferred to QuickBooks at integration but Work in 
Progress and Service History information is not transferred.
While integrated, transactions, such as Credit Refunds and customer information, such as 
Customer name changes, processed in Manage are also sent to QuickBooks. Transactions 
entered in QuickBooks are not transferred to Manage.
Refer to Appendix A: Transaction Mapping for information about which transactions are sent 
from Manage to QuickBooks.

Networked QuickBooks

Manage supports networked server access to QuickBooks. QuickBooks uses the Remote Data 
Sharing (RDS) Client and Server components to simplify the setup, configuration, and 
accessing of the QuickBooks company file (.QBW file) on the Manage server from a Manage 
client computer.

A Manage client machine does not need to have QuickBooks installed on it. Only the Manage 
server needs to have QuickBooks installed so that invoice information from Manage client 
machines can be sent to the QuickBooks application on the server.

Warning: 
Changing company files in QuickBooks, when QuickBooks is 
integrated with Manage, can negatively impact Manage. If 
you have multiple businesses and need to access a differ-
ent company file make sure that Manage does not attempt 
to write to the company file.
Changing the tax items and accounts in QuickBooks that 
were created by the integration process could prevent Man-
age from sending updates to QuickBooks.
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Reconciling Accounts

When you integrate ALLDATA Manage with QuickBooks, Manage attempts to set up accounts, 
payment records, credit memos and invoices for the Work in Progress in the Manage data-
base.

Any discrepancies in the orders on Manage or in the existing records in QuickBooks can cause 
problems with synchronization. Some discrepancies, such as credit-versus-balance-due con-
flicts, cause the integration process to stop and a report to be printed. Therefore efforts 
should be made to clear the discrepancies and reconcile customer records.

Data in Manage and QuickBooks

If customer records exist in both Manage and QuickBooks, duplicate entries are created at 
integration. These duplicate entries should be minimized by reconciling the accounts (Refer 
to “Chapter 5: Reconciling Accounts and Reports” on page 18) before integration. 

During integration the following information from Manage is added to QuickBooks:

• Payments or adjustments to accounts

• Accounts Receivable balances

• Credit Balances

Data in Manage

If data exists in Manage and not in QuickBooks, when integration is activated a customer 
record and an opening balance invoice are created in QuickBooks for all Manage customers 
with work in progress.

After integration, when an invoice is posted in Manage, Manage sends the invoice information 
to QuickBooks. This information should not be manually entered into QuickBooks because it 
may lead to duplicate entries.

Data in QuickBooks

If your shop has been using both Manage and QuickBooks without integration, you may have 
already created customer records and invoices in QuickBooks for customers that are in Man-
age. Refer to “Reconciling records created when using QuickBooks without integration” on 
page 18 for specific instructions.
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Chapter 1: About this Installation and Setup Guide
This manual is designed to help you install your QuickBooks application, set up your Quick-
Books company file (.qbw) and settings, and activate the Accounting integration.

If Security Profiles are configured in Manage, verify that you have the correct password level 
access to Accounting Setup. For more information refer to the Security Profiles topic in the 
Manage help system.
Because this Installation and Setup Guide is concerned with getting you started it does not 
cover topics such as deleting information. See the help systems in Manage and QuickBooks 
for more comprehensive information.

Help System

Manage and QuickBooks have comprehensive help systems that you can view and navigate 
on your computer screen. If you do not find an answer or procedure in this manual, look for 
it in the help system.

Manage Help

Find assistance with Manage by using the extensive Manage support resources which include 
the Help System.

To access the Manage help system:

1. In Manage, select the Help menu.
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2. Select Contents and Index.

Result: The help system opens in a separate window. Click the books and topics on the 
left side to browse through the contents, or select the Index or Search tab to enter 
search words.
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QuickBooks Help

Find assistance with QuickBooks by using the extensive QuickBooks support resources which 
include the Help System, and various support options that are available depending on the 
version of QuickBooks software installed.

To access QuickBooks information using the Help system:

1. In QuickBooks, select the Help menu.

2. Select QuickBooks Help.
Result: The help system opens in a separate frame or window. Select a relevant topic or 
use the Search tab.

To access QuickBooks information using the Support search:

1. In QuickBooks, select the Help menu.

2. Select the Support option.

3. You will be presented with various support options depending on the version of Quick-
Books installed.



Accounting Integration with QuickBooks Installation and Setup Guide

Chapter 2: Installation, Setup and Integration Outline 10

Chapter 2: Installation, Setup and Integration Outline

1. Install QuickBooks (Refer to “Chapter 3: Installing QuickBooks” on page 11 for details.).

Note: In a networked environment, both QuickBooks and Manage need to be installed on 
the same server PC.

2. Start QuickBooks.

3. Set up QuickBooks (Refer to “Setting Up QuickBooks” on page 14), including:

• Creating a new company of company type Service Business in QuickBooks (Service is 
recommended in order for the correct accounts to be generated)

• Setting up accounts and items

• Setting sales tax rates (except Canadian versions)

• Setting sales tax items (Canadian version only)

4. Before activating QuickBooks, start Manage and configure the Tax Rates and Tax Rates 
Schedules. Refer to “Setting Up Manage” on page 12.

5. In Manage, activate QuickBooks accounting integration. Refer to “Chapter 6: Accounting 
Setup and QuickBooks Integration” on page 24.

6. Proceed with your normal Manage activities, such as, creating estimates and posting 
orders. As activities create accounting information the information is sent to QuickBooks.

Warning: 
Changing company files in QuickBooks, when QuickBooks is 
integrated with Manage, can negatively impact Manage. If 
you have multiple businesses and need to access a differ-
ent company file make sure that Manage does not attempt 
to write to the company file.
Changing the tax items and accounts in QuickBooks that 
were created by Manage could prevent Manage from send-
ing updates to QuickBooks.



Accounting Integration with QuickBooks Installation and Setup Guide

Chapter 3: Installing QuickBooks 11

Chapter 3: Installing QuickBooks

Pre-Installation Checklist

Before You Begin:

1. Verify that you have the required software:

• Windows 2000 or later

• QuickBooks Pro 2004 (or higher) or any version of QuickBooks Premier

• MANAGE 

2. Verify that you have:

• QuickBooks media and License

• Any documentation or instruction sheets that came with the QuickBooks media

QuickBooks Installation

1. Close any programs that might have an impact on the installation process.

2. If you are installing QuickBooks (QuickBooks Pro 2004 or Premier or later) from CD-ROM 
or DVD, insert the CD-ROM or DVD into your disc drive. The install program should start 
automatically.

3. Install QuickBooks by following the on-screen instructions and by referring to any docu-
mentation or instructions that came with the media.

4. Complete the following windows or questions, if they are presented:

• Check and download the latest critical installation updates? - Select Yes to download 
the latest updates from Intuit or select No to skip the latest update download.

• License Agreement - You must accept the terms in order to continue to install the 
software.

• Number of users - Select one user, unless you are planning to network QuickBooks on 
multiple computers.

Note: In a networked environment, both QuickBooks (with the Company File Server) 
and Manage need to be installed on the same server PC.

• License Number and Product Number - Enter the provided numbers.

• Select Installation Folder - Select an easy to locate folder.

You may need to restart your computer.

5. Start setting up QuickBooks. Refer to “Setting Up the QuickBooks Company File using the 
EasyStep Interview” on page 14.
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Chapter 4: Setting Up Manage and QuickBooks Prior to Integration

Setting Up Manage

Verify that you have completed the QuickBooks setup tasks before starting to set up the 
Manage accounting integration.

When you are ready to set up Accounting Integration in Manage, refer to in the MANAGE 
Quick Reference Guide.

Setting Up Manage prior to Accounting Integration

If you are using a Canadian Version of QuickBooks, you will need to configure a Canadian 
Postal Code in the company setup window in Manage before integration. 

The non-Canadian versions of QuickBooks require that the tax rates in Manage be set to 
match the QuickBooks settings. Use the "Setting Tax Rates and Schedules" below.

The Canadian Versions of QuickBooks do not use the tax rates in Manage and the QB Tax 
Item fields will not display when Manage is integrated QuickBooks. Refer to the procedure in 
“Tailoring the Tax rate setting in QuickBooks, Canadian Version for integration with Manage” 
on page 16.

Setting Tax Rates and Schedules

Use the MANAGE Setup menu to set the Tax Rates and Tax Rates Schedules that affect 
accounting.

1. From the Setup shortcut bar or menu select Company Setup.

2. Select the Tax/Markups tab.

3. Type and select your shop’s options. (See the following descriptions).
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Tax Rates Matrix

In the Tax Rates section, the name of the schedule currently set as the default is displayed in 
the Default Tax Schedule field. 
Use the Tax Matrix Setup button to open the Tax Rate Setup window, where you can con-
figure the tax rates and tax schedules and where you can select which schedule to use as a 
default Tax Schedule.

Tax Rate Setup

On the Tax Rates tab:

1. Click New to activate the Tax Rate Name field for input. 

2. Enter a name for the new Tax Rate.

3. Select a Tax Rate Type selection boxes:

• Regular 

• Compound (only one compound tax can be configured per database)

4. Use the grid to add ranges and tax percentages. 

5. Click New to add more Tax Rates or select the Tax Schedule tab.
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On the Tax Schedule tab:

1. Click New to activate the Schedule Name field for input. 

2. Enter a name for the new Tax Schedule.

3. If appropriate, use the Default Schedule box to set the current schedule as the default. 

4. Use the buttons: Add Selected >, < Remove Selected, or << Remove All to move 
Tax rates between the Tax Rates Available and Tax Rates Included grids and click 
Save. 

5. Click Close.

6. Click Submit. 

Setting Up QuickBooks

You need to create or have a company file that has never been integrated with Manage to use 
during the accounting integration process.

Before you begin creating the Company file, make sure you have the following information:

• Your company name and address.

• The industry and what the company sells (products, services or both).

• Sales tax information, including an item name, a description, a rate, and the name of 
the government agency to which you pay sales taxes.
Note: Manage always charges a sales tax of $0.00 or greater and QuickBooks must 
match Manage. For example, if in your state there is a 7.75% tax on parts and no tax 
on labor, you need two tax rates (7.75 % and 0%) configured in Manage and Quick-
Books (except Canadian QuickBooks versions).

Setting Up the QuickBooks Company File using the EasyStep Interview

1. Start QuickBooks by clicking on the desktop icon.

2. Complete the following windows or questions:

• Automatic Update window - Select Yes to download the latest updates from Intuit or 
select No to skip the latest update.

• Welcome window or “No Company Open” window - Select Create a new Company to 
start creating a new company file. Refer to “Updating QuickBooks Software” on 
page 51, if you already have a company file with data.

3. If the EasyStep Interview doesn’t start automatically, start the EasyStep Interview from 
the File menu, New Company option.

This interview differs depending on the version of QuickBooks installed. Use the Quick-
Books Help to learn how to navigate though the interview but be sure to address the fol-
lowing items as described in the table:
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4. If installing QuickBooks 2006 or later, be sure to select Switch to Multi-user Mode from 
the File drop-down menu.

5. To see the tax accounts that were set up for your company refer to “Verifying Tax Rate 
Settings in QuickBooks, non-Canadian Versions” on page 68.

Field Description

Company name This is a required field. 

Province (Canadian 
Version only)

This field is required. If the country is the United States, then the Prov-
ince drop-list will contain state abbreviations. If the country is Canada, 
then the Province drop-list will contain Canadian province abbrevia-
tions. If the country is other than US or Canada, then the state drop-
list is not available.

Administrator pass-
word

If installing QuickBooks 2006 or later, be sure to enter an administrator 
password. If you set a password, make sure that you record the infor-
mation for later use. 

Filename for New 
Company

A new QuickBooks data file is created with the name entered and a 
.qbw extension.

Your Industry or 
what the company 
sells (products, ser-
vices, or both)

Indicate that your company is a service-based business or sells ser-
vices. This will ensure that the QuickBooks will generate the correct 
accounts. 

Do you charge sales 
tax?

Always select Yes to indicate that you collect a sales tax on parts or 
services. 
Note: Manage always charges a sales tax of $0.00 or greater and 
QuickBooks must match Manage (except Canadian QuickBooks ver-
sions). 

Default list of 
accounts

Select Yes to create a list of default accounts.

Canadian Revenue 
Agency Business 
number and PST or 
QST Registration 
numbers 
(Canadian Version 
only)

Enter the Canadian Revenue Agency number assigned to your busi-
ness. These fields only display when installing the Canadian version of 
QuickBooks. 

Sales tax informa-
tion

Enter an item name, a description, a rate, and the name of the govern-
ment agency to which you pay taxes. 

Note: The item name is used to create a vendor account for journal 
entries and is entered in Manage on the Accounting Setup window.
This field only displays when installing the United States version of 
QuickBooks. 

Create Estimates in 
QuickBooks?

Select No to allow Manage to create estimates. 
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Tailoring the Tax rate setting in QuickBooks, Canadian Version for integration with 
Manage 

The Canadian Version of QuickBooks does not require compatibility with the tax settings in 
Manage but instead requires that additional Tax Rate settings be configured prior to integra-
tion with Manage. 
If you will NOT be using the Canadian version of QuickBooks you can skip this procedure and 
refer to the procedure in “Setting Up Manage prior to Accounting Integration” on page 12. 

The two Tax Codes required in QuickBooks, Canada for use with Manage will need two Sales 
tax items for each Tax Code.

Add Sales Tax item for Purchase.

1. From the List menu click Item List.

2. Click Item and New.
Result: The New Item window displays.

3. From the Type drop-list select Sales Tax Item. 

4. Complete the Sales Tax Item window as follows:

5. Click OK. 

6. Return to the Sales Tax Item window by repeating the above steps and complete the 
window as follows:

Field Input

Sales Tax Name Tax Calculated On Invoice

Description Tax Calculated On Invoice

Tax Rate (%) or Amt 0.00%

Tax Agency Receiver General 

Sales Tax Return Line
Line 103 GST/HST collected or 
collectible

Field Input

Sales Tax Name Tax Calculated On Invoice (P)

Description 
Tax Calculated On Invoice (Pur-
chase)

Tax Rate (%) or Amt 0.00%

Tax Agency Receiver General 
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7. Click OK. 

8. Return to the Sales Tax Item window by repeating the above steps and complete the 
window as follows:

9. Click OK. 

Sales Tax Return Line Line 106 Input tax credits (ITCs) 

Field Input

Sales Tax Name Sales Tax

Description Sales Tax

Tax Rate (%) or Amt 0.00%

Tax Agency Receiver General 

Sales Tax Return Line
Line 103 GST/HST collected or 
collectible

Field Input
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Chapter 5: Reconciling Accounts and Reports
Unless you are installing Manage and QuickBooks for the first time, customer records will 
exist and may need to be reconciled. Reconciling customer records before starting the inte-
gration, minimizes the chances of synchronization and billing problems.

• If you have been using QuickBooks without Manage, refer to "Reconciling records cre-
ated when using QuickBooks without integration".

• If you have been using Manage without QuickBooks, refer to "Reconciling Work in 
Progress records before accounting integration".

• If you have been using Manage integrated with QuickBooks, the integration process 
should not be re-initiated. If accounting integration was deactivated, you should cre-
ate a new company file in QuickBooks and reconcile the records in Manage as 
described in "Reconciling Work in Progress records before accounting integration".

Reconciling records created when using QuickBooks without integration

If your shop has been using both Manage and QuickBooks without integration, you may have 
already created customer records and invoices in QuickBooks for customers that are in Man-
age.

When integrating Manage with QuickBooks, a customer record and an opening balance 
invoice are created in QuickBooks for customers with work in progress in Manage. These cus-
tomer records and opening balance invoices may be duplicates of preexisting QuickBooks 
customer records and opening balance invoices.

For example: The QuickBooks created invoice for John Smith and the Manage created 
invoice for John Smith SC#000001 are duplicates.

To resolve duplicate QuickBooks customer records and opening balance invoices:

1. In QuickBooks, merge the customers by opening the QuickBooks created customer (John 
Smith) and over-typing the name with the name of the Manage created customer record 
(John Smith SC#000001).

Result: QuickBooks will merge the customer records under the name of the Manage cre-
ated customer record (John Smith SC#000001).

2. Void the opening balance invoices created under the pre-integration name (John Smith).

Result: Payments made in Manage after integration are applied to the remaining opening 
balance invoice created by Manage (John Smith SC#000001).

Reconciling Work in Progress records before accounting integration

When you integrate ALLDATA Manage with QuickBooks, Manage attempts to set up accounts, 
payment records, credit memos and invoices for the Work in Progress in the Manage data-
base.
Any discrepancies in the orders on Manage or in the preexisting records in QuickBooks can 
cause problems with synchronization. Some discrepancies, such as credit-versus-balance-
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due conflicts, cause the integration process to stop and a report to be printed. Therefore 
efforts should be made to clear the discrepancies and reconcile customer records.

Use the following reports in the recommended order to clear possible discrepancies 
before initiating the integration:

1. Balance Due - If a balance due exists for a customer when Manage integrates with 
QuickBooks, Manage will create an invoice in QuickBooks with an open balance. To avoid 
these invoices in QuickBooks, the customer balances can be zeroed out by applying pay-
ments in Manage to compensate for the amounts due. Refer to “Clearing the Customer 
Balances Due” on page 19.

2. Customer Credit Balances - ALLDATA Manage will not integrate with QuickBooks unless 
all customer credit balance amounts in ALLDATA Manage are zero. These balances can be 
cleared by issuing the customer a temporary refund to compensate for the credit balance. 
Refer to “Clearing Customer Credit Balances” on page 20.

3. Negative Customer Balances - If you attempt to integrate with QuickBooks while a 
negative balance due or a credit versus balance due conflict exists, Manage will generate 
an error message and a report. The report lists customers with conflicts that need to be 
resolved before the integration can proceed. These conflicts can be cleared by issuing the 
customer a temporary refund to compensate for the negative balance. Refer to “Clearing 
the Negative Customer Balances” on page 22.

4. Current Payments and Deposits - If Manage contains customers with Work in Progress 
that includes cashiered (paid) but un-posted invoices or repair orders with deposits, dur-
ing integration credit memos for these customers will be created in QuickBooks. To avoid 
conflicts with credit memos and new invoices, post all invoices that are paid in full and 
credit all deposits on repair orders prior to integration. Refer to “Clearing the Current Pay-
ments and Deposits” on page 22.

Note: After printing these reports you should save them for use during and after integration. 

Clearing the Customer Balances Due

To clear the balances due before integrating with QuickBooks, use the Balance Due 
report:

1. From the Reports menu, select Customer Reports > Balance Due Statement for All and 
print the report.
Result: The Balance Due report prints.

2. If the Balance Due Report lists customers with balances due, eliminate the balance by 
applying payments (Refer to Table 1 on page 19) to each customer listed.

Table 1: Applying Payments

1. From the Main shortcut bar, select Customers.

2. In the Customers list select the customer and click Edit.
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3. After applying payments to customers, run the Balances Due Statement for All report 
again to verify that no customers are listed. 

Note: While Manage is integrated with QuickBooks, payments applied to ALLDATA Manage 
are automatically applied to QuickBooks.

Clearing Customer Credit Balances

To clear Customer Credit Balances before integrating with QuickBooks, use the Customer 
Credit Balances report:

1. From the Reports menu, select Customer Reports > Customer Credit Balances and 
print the report. 
Result: The Customer Credit Balances report prints. 

3. In the Edit Customer window, select the Payment Record tab 
and verify the Balance
Due amount.

4. Select the invoice or counter sale and then click Record Pay-
ment.

Result: An Apply Payment window displays.

5. From the Payment Type drop-list, select Cash, Credit Card, 
Check, Debit or Other.

TIP: Use Payment Type “Other” to help identify transactions that 
will be posted as "paid in full" before full payment was actually 
made. 

6. Enter any options to go with the payment type (i.e. check 
number, authorization number, credit card type, expiration 
date, etc.)

7. From the Payment Date drop-down calendar, select the date 
of payment. It defaults to the current date.

8. In the Payment Amount field, verify that the amount is equal 
to the amount in the Balance Due field. 

Result: If no balance remains and the invoice is fully paid, the 
Payment Record window closes and the printing of the receipt 
and posting of the invoice reminder messages display.

9. Click Apply.

Result: The updated payment record displays.

10. Click Submit.

Note: These payments can be made temporarily and undone 
after integration.

Table 1: Applying Payments
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2. If the Customer Credit Balances Report lists customers with credit balances, they must be 
cleared by issuing refunds in ALLDATA Manage to compensate for the credit balance. 

Note: These refunds can be made temporarily and undone after integration.

3. Apply refunds (Refer to Table 2 Apply Refunds) for all customers with credit balances.

4. After applying refunds to all customers with credit balances, run the Customer Credit 
Balances report again to verify that no customers are listed.

Note: While Manage is integrated with QuickBooks, payments applied to ALLDATA Manage 
are automatically applied to QuickBooks.

Table 2: Apply Refunds

1. From the Main shortcut bar, select Customers.

2. In the Customers list, select the customer and click Edit.

Result: The Edit Customer window displays. 

3. Open the appropriate Refund dialog box:

• For order refunds, select the Service History tab and 
click Order Refund

 -Or-

• For credit refunds, select the Payment Record tab 
and click Credit Refund. 

Result: A Refund for Invoice or a Customer Credit 
Refund dialog box displays.

4. In the Refund Type area, select Cash, Check, or Credit 
Card. 

5. In the Refund Amount field, enter the dollar amount of the 
refund. This should be equal to the amount of the Total 
Minus Refunds.

6. Click Submit.

Result: 

• For order refunds, the refund is applied to the cus-
tomer record.

 -Or-

• For credit refunds, the refund is applied to the cus-
tomer record 

7. Click Submit when you are finished. 

Result: The Customers list is displayed.

8. Click Close.
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Clearing the Negative Customer Balances

To clear negative balance conflicts before integrating with QuickBooks, use the Balance 
Due report:

1. From the Reports menu, select Customer Reports > Negative Customer Balances and 
print the report. 
Result: The Negative Customer Balances report prints.

2. If the Negative Customer Balances Report lists customers with a credit versus balance 
due conflict, they must be cleared by issuing refunds in ALLDATA Manage to compensate 
for the negative balance. 
Note: These refunds can be made temporarily and undone after integration.

3. Apply refunds (Refer to Table 2 Apply Refunds on page 21) for all customers with credit 
conflicts.

4. After applying refunds to all customers with credit conflicts, run the Negative Customer 
Balances report again to verify that no customers are listed. 

Note: While Manage is integrated with QuickBooks, payments applied to ALLDATA Manage 
are automatically applied to QuickBooks.

Clearing the Current Payments and Deposits

Work in Progress that includes cashiered (paid) but un-posted invoices or repair orders with 
deposits can cause conflicts when Manage is integrated with QuickBooks. If these are not 
reconciled, credits will be created in QuickBooks that are not connected to an invoice. When 
the invoice is later posted or additional payments are made in Manage the invoice written to 
QuickBooks will not automatically connect to the credit.
To avoid conflicts with credit memos and new invoices, post all invoices that are paid in full 
and credit all deposits on repair orders prior to integration.

To clear cashiered and un-posted invoices and deposits on Work in Progress before inte-
grating with QuickBooks, use the Current Payments and Deposits report:

1. From the Reports menu, select Customer Reports > Current Payments and Deposits 
report.
Result: The Current Payments and Deposits report prints.

2. If the Current Payments and Deposits Report indicates un-posted invoices that you want 
to clear (Invoice - Cashiered), you can post the cashiered invoices (Refer to Table 3 on 
page 22).

Table 3: Post the Cashiered Invoices

1. From the Main shortcut bar, select Work in Progress, Saved 
Estimates button.

2. Click on the Cashiered tab.
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3. If the Current Payments and Deposits Report indicates deposits on repair orders. You can 
wait until the repair order is completed and posted before integrating with QuickBooks or 
you can reconcile the credit memo (refer to Table 4 on page 23) after integration.

4. After posting cashiered invoices, run the Current Payments and Deposits report again 
to verify that only the appropriate customers are listed.

Notes: 

• If you chose not to post all of the invoices with payments, after integrating with 
QuickBooks, remember to remove the credits in QuickBooks relating to the un-posted 
invoices.

• While Manage is integrated with QuickBooks, payments applied to ALLDATA Manage 
are automatically applied to QuickBooks.

3. Locate the cashiered invoice.

4. Double-click on the invoice to open it.

5. Click the Post button located in the lower right hand corner of 
the ticket.

Result: The invoice is closed and sent to the Service History 
table.

Table 4: Reconcile the Credit Memo

To reconcile the Credit memo:

1. Make a note of the repair order number. 

2. After integrating Manage with QuickBooks, locate and delete 
the credit memo.

Note: While Manage is integrated with QuickBooks, payments 
applied to ALLDATA Manage are automatically applied to Quick-
Books.

Table 3: Post the Cashiered Invoices
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Chapter 6: Accounting Setup and QuickBooks Integration

Pre-integration Checklist

Before You Begin:

Verify that Manage and QuickBooks have been installed.

Note: In a networked environment, both Manage and QuickBooks need to be installed on the 
same server PC.
In order to successfully complete the accounting setup and QuickBooks integration, you must 
complete the pre-integration checklist for Manage and QuickBooks. Once the requested 
reports from the checklist have been faxed to ALLDATA you will be contacted and scheduled 
for an Integration Setup Assistance call.

QuickBooks Pre-integration Checklist

Note: If you are using QuickBooks 2006 (or greater), you must be in multi-user mode, (In 
QuickBooks, from the File menu, select Switch to Multi-user Mode).

To view a step-by-step video on the following checklist tasks use the Manage toolbar to select 
Tips > MANAGE\QuickBooks integration > MANAGE Pre-integration.

Create a QuickBooks company file (if one does not already exist).

• Select File

• Select New Company

• Select Start Interview

• Complete the EasyStep Interview Wizard

Note: When asked “What do you sell?”, Service or Both are recommended in order for 
the correct accounts to be generated.

Switch to Multi-user Mode.

• Select File

• Select Switch to Multi-user Mode

Set the Sales Tax preferences to indicate that you DO charge sales tax.

• Select Edit

• Select Preferences

• Select Sales Tax

• Select Company Preferences tab

• In the Do you charge sales tax? field, select Yes

• Click OK
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Create sales tax items for non-Canadian versions of QuickBooks. (If you provide non-tax-
able services, you must still have a zero sales tax item configured.)

• Select Edit

• Select Preferences

• Select Sales Tax

• Select the Company Preferences tab

• In the Set Up Sales Tax Item section, click the down arrow for the Most common 
Sales Tax drop down box and select <Add New>.

• In the New Item dialog box, enter a Type, Tax Name, Tax Rate, Tax Agency, and click 
OK.

• Add more tax rates as appropriate and click OK when done

Create sales tax items for Canadian versions of QuickBooks. (If you provide non-taxable 
services, you must still have a zero sales tax item configured.)

• From the Lists menu, select Item List. 

• Select Preferences

• Select Item button.

• Select the New

• In the New Item window, from the Type list, select Sales Tax Item. 

• Complete the Sales Tax Item window as describe in “Tailoring the Tax rate setting in 
QuickBooks, Canadian Version for integration with Manage” on page 16. 

Verify that at least one Sales Tax configuration includes an item name, a rate (0.00% or 
greater), and the name of the government agency to which you pay sales taxes.

Note: Manage always charges a sales tax of 0.00% or greater and QuickBooks must 
match Manage.

• Select Lists

• Select Sales Tax Code List

• Select an item and double click on it

Set automatic backups.

• Select File

• Select Save Copy or Backup...

• Select Backup copy 

• Select Local Backup

• Select a schedule backup option

• Define the backup options

• Click Finish

Run the Customer Balance Detail report (in QuickBooks).

• Select Reports
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• Select Customers & Receivables

• Select Customer Balance Detail

Verify that your QuickBooks company file (QBW backup *.QBB) is not located on your PC 
desktop but is in a QuickBooks directory.

• Select File

• Select Save Copy or Backup...

• Select Backup copy 

• Select Local Backup

• Verify the Backup Current Company Filename (*.QBB)

Backup your QuickBooks company file, appending the name with “BeforeSC and selecting 
the ”Add the date and time of the backup to the filename” option.

• Select File

• Select Save Copy or Backup...

• Select Backup copy 

• Select Local Backup

• Verify the backup location and name (including BeforeSC)

• Click OK

• After backing up your company file you may want to return to the Backup Options 
window and remove the appending portion of the name (beforeSC)

Set the lntegrated Applications preference to allow other applications access to your com-
pany file.

• Select Edit 

• Select Preferences

• Select lntegrated Applications

• Select Company Preferences tab

• Verify that the option boxes are unchecked

• Click OK

Set the Reports preference to refresh reports automatically.

• Select Edit

• Select Preferences

• Select Reports & Graphs

• Select My Preferences tab 

• Select Refresh Automatically 

• Click OK
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Manage Pre-integration Checklist

Complete the following items in Manage:

Verify that the sales taxes in Manage match the sales tax items in QuickBooks.

In Manage post any invoices that are fully paid but not posted.

Run and print the:

• Balance Due/Accounts Receivable report

• Customer Credit Balances report

• Negative Customer Balances report

• Current Payments and Deposits report

Reconcile Work in Progress records using the above reports. Refer to “Reconciling 
Accounts” on page 6.

Clear up any pending customer balances from the Balance Due/Account Receivable 
report.

Clear up any pending customer credit balances from the Negative Customer Balance and 
Customer Credit Balances reports.

Password-protect the Accounting Setup screen so only approved persons can access it.

Set automatic backups to occur once a day.

Back up your Manage database, appending the name with "BeforeQB".

Fax both checklists, QuickBooks Pre-integration and Manage Pre-integration, and the reports to 
ALLDATA at 1-800-829-3329. 

An ALLDATA representative will contact you to schedule the integration setup assistance call. 

WARNING: If you integrate your Manage information without 
verifying the following items, your financial data may NOT be 
accurate!

IMPORTANT! If an ALLDATA representative is assisting you 
with the integration, you will need to fax these four reports, 
this Manage Pre-integration checklist and the QuickBooks Pre-
integration checklist to ALLDATA at 1-800-829-3329. An ALL-
DATA representative will contact you to schedule the integra-
tion setup assistance call.
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Accounting Setup and Integration

Once all the accounting installation tasks are complete and the accounts are reconciled the 
ALLDATA representative will be in contact to assist you to activate the integration, as follows: 

1. Verify that Manage is running.

2. Verify that QuickBooks is running and that the company file is active.

3. From the Setup shortcut bar in Manage, select Accounting Setup.
Result: The Accounting Setup window displays. Initially the Accounting Setup window is 
password protected to prevent the unauthorized activation of accounting integration. If 
Manage has never been integrated with Manage, the Password field and warning message 
is displayed.

4. Enter the password provided by Customer Support. The Accounting Setup window is 
unlocked and you will not be prompted for the password again.

5. In the QuickBooks company file field, use the Browse button to select the appropriate 
file.

6. Select the Integrate with QuickBooks box to initiate the integration process.
Result: A reminder message displays to have you verify that no QuickBooks reports are 
open.

7. Click OK.
Result: Under certain circumstances other messages display to warn you about problems 
such as:

• Payments on non-posted invoices need to be converted to credits.

• If any one customer has both balances due and credit balances, integration cannot 
continue.
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8. When all messages are addressed, the integration starts.

Result: Both the QuickBooks and Manage databases are updated with the required 
Accounts and Items.
Note: When integration with QuickBooks is complete the QuickBooks Accounts and 
QuickBooks Items grids are updated and the QB Parts Tax Item and QB Labor Tax Item 
fields are activated.
 

9. From the list for QB Parts Tax Item and QB Labor Tax Item, select a sales tax item 
name. These lists contain the Sales Tax names created in QuickBooks, using Preferences 
> Sales Tax and can be viewed in QuickBooks on the Item List (type is Sales Tax Item).

Note: If the values for tax rates in the Manage Company Setup table do not match the 
value for the QuickBooks Sales tax item selected, an error message is displayed and the 
values will need to be matched.
To see the tax rates and accounts that were set up for your company in QuickBooks, refer 
to “Verifying Tax Rate Settings in QuickBooks, non-Canadian Versions” on page 68.
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10.Using the QuickBooks Accounts and QuickBooks Items tabs, verify that a default checking 
account, named Checking Account and a default cash account, named Petty Cash are cre-
ated. These accounts are used for journal entries from Manage.

Note: These accounts can be renamed in QuickBooks, but Do Not delete them.
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11.Select the Account Summary Setup tab to assign account codes to account descriptions. 
Account descriptions correspond to revenue types used by Manage and cannot be config-
ured. Income Account Codes and Expense Account Codes are used on the Account Sum-
mary report (Refer to “Revenue Reports” on page 161 in the MANAGE Quick Reference 
Guide).

12. In the grid, select a description field and type an account number. 
Note: Account Codes cannot be longer than fifteen characters.
When done with the Account Summary Setup tab, click the QuickBooks Integration tab.

13.Use the Launch QuickBooks on open check box to determine if Manage will verify that 
QuickBooks is activated when it is initiated.

Note: While integration is activated and Manage is running the integrated company file 
needs to be open in QuickBooks.

14.When done with the accounting setup, click Submit.
Note: After integration is activated, both the Manage database and QB company file 
should be backed up to new files. For more information about backing up these files, refer 
to “Backing up QuickBooks and Manage” on page 71.



Accounting Integration with QuickBooks Installation and Setup Guide

Chapter 6: Accounting Setup and QuickBooks Integration 32

Validating QuickBooks Accounts and Items in Manage

After the Integrate with QuickBooks process is complete the QuickBooks Accounts and Quick-
Books Items grids on the Accounting Setup window are updated. You can use these grids to 
verify that the following records are listed with the correct descriptions.

The QuickBooks Accounts grid displays the accounts needed by Manage. To update the 
accounts of types Other Income, Income, and Bank, click the Refresh QB Data button.

QuickBooks Accounts tab

*Notes:   If this account name or type is changed, you will not be able to post invoices or write 
payments from Manage to QuickBooks.

Account Name Type

Accounts Receivable* Accounts Receivable*

Applied Credits
Other Income

Checking Account Bank

Core Revenue Income

Customer Deposits Other Current Liability

Deposits Other Income

Discount – Labor Other Income

Discount – Parts Other Income

Discount – Sublet Other Income

HazMat Revenue (non-tax) Income

HazMat Revenue (taxable) Income

Labor Revenue (non-tax) Income

Labor Revenue (taxable) Income

Parts Revenue (non-tax) Income

Parts Revenue (taxable) Income

Petty Cash Bank

Returns and Allowances Income

Shop Supplies Revenue (non-
tax)

Income

Shop Supplies Revenue (tax-
able)

Income

Sublet Revenue (non-tax) Income

Sublet Revenue (taxable) Income
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QuickBooks Items tab

QB Item Type

Cores Other Charge

Credit Other Charge

Discount Labor Discount

Discount Parts Discount

Discount Sublet Discount

Non-taxable HazMat Other Charge

Non-taxable Labor Service

Non-taxable Part Non-inventory

Non-taxable Shop Supplies Other Charge

Non-taxable Sublet Other Charge

Tax Calculated On Invoice Sales Tax Item

Taxable HazMat Other Charge

Taxable Labor Service

Taxable Part Non-inventory Part

Taxable Shop Supplies Other Charge

Taxable Sublet Other Charge

Note: All Sales Tax items are also added to the QuickBooks 
Items tab. This includes any interview defaults (such as Out of 
State), any created by the integration process (Tax Calculated 
On Invoice), and any created by the user in QuickBooks (such 
as state sales tax, labor tax, parts tax, etc.).

Warning: 
Changing the tax items and accounts in QuickBooks that 
were created by the integration process could prevent Man-
age from sending updates to QuickBooks.
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Chapter 7: Setting Up Networked QuickBooks
QuickBooks allows you to use the Remote Data Sharing (RDS) application to update the 
accounting files on a server PC from a client PC in a networked environment. The QuickBooks 
software runs with Manage (Release 4.4 or later) on a server PC and processes updates from 
remote clients using the Remote Data Sharing (RDS) application.

Before you can have a Manage client send data to a networked QuickBooks database you 
need to install and setup the MANAGE, QuickBooks, and Remote Data Sharing Server (RDS) 
software on the server and MANAGE and Remote Data Sharing Client (RDS) software on the 
client PC.
Once installed, the server needs to be running the QuickBooks application and the RDS 
server application and the client needs to be running the RDS Client application in order for 
client PCs to be able to write to the QuickBooks server database. 

Manage needs to be installed but does not need to be running on the server PC in order for 
the client PC to write data to the server QuickBooks database.

When using Manage, QuickBooks should run only on the server PC.
Note: Before beginning to set up Networked QuickBooks, it is recommended that you verify 
that your network is using a manual IP address scheme.

Setting Up Networked QuickBooks

On the Server PC:

1. Install QuickBooks on the server PC. Refer to “Chapter 3: Installing QuickBooks” on 
page 11.

2. Install Manage (Release 4.4 or later) on the server PC. 

3. Set up QuickBooks on the server. Refer to “Setting Up QuickBooks” on page 14.

4. Start Manage on the server PC.

5. On the server PC (never on the client PC), use the Accounting Setup window to integrate 
with QuickBooks. Refer to “Chapter 6: Accounting Setup and QuickBooks Integration” on 
page 24.

6. On the server PC, install the QuickBooks RDS Server software. Refer to “Install the Quick-
Books RDS Server Software” on page 36.
Result: The QuickBooks Remote Data Sharing Server - Setup window displays.

7. Complete the RDS server PC setup. Refer to “To Setup the QuickBooks RDS Server Appli-
cation” on page 38.

8. Open QuickBooks with the integrated company file and then launch the QB RDS server 
application. Refer to “Launching the RDS Server” on page 44. The server application 
should remain open on the server PC while you install the client software on the client 
PCs.
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On the Client PC:

1. On the Client PC, install the RDS Client software. Refer to “Install the QuickBooks RDS 
Client Application” on page 41.
Result: The QuickBooks Remote Data Sharing Client - Setup window displays. 

2. Complete the RDS Client PC setup. Refer to “Setup the QuickBooks RDS Client Applica-
tion” on page 42.

3. With the Remote Data Sharing Client - Console window open on the client PC, open the 
Accounting Setup window on the server PC.

4. On the Accounting Setup window, click Refresh QB Data.
Result: On the Client PC, the Application Registration dialog displays.

5. Enter the RDS login and password that you created on the RDS server and click Yes, 
Always. 

6. A confirmation box displays, click Yes.

7. Verify the Current Activity information on the server console window and click Exit.
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Install the QuickBooks RDS Server Software

1. From the Start menu, select Programs > ALLDATA > ALLDATA Manage > Intuit RDS 
Server Install.
Result: The QuickBooks Remote Data Sharing Server - InstallShield Wizard window dis-
plays.
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2. Click Next and on the Ready to Install the Program window, click Install.

3. When the InstallShield Wizard completes, click Finish.
Result: The QuickBooks Remote Data Sharing Server - Setup window displays.
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To Setup the QuickBooks RDS Server Application

1. From the QuickBooks Remote Data Sharing Server – Setup window, enter a login name 
and password.
Note: This password is only used for the RDS Server and must be at least 6 alphanu-
meric characters in length.
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2. Repeat the password and click OK.
Result: The QuickBooks The RDS Server – Console window displays.

3. With the QB company file open on the server PC, in the Console window, click Change 
Options to open the Company Files for Remote Access dialog box.

 

4. Select the open company file option and click OK.
Result: The QuickBooks The RDS Server – Console window displays.
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5. On the RDS Server – Console window, click Manage.
Result: The RDS Server Manage window displays.

6. Click Advanced Settings.

7. Verify that the Server Port is set to 3790 and that the Queue length is at least 15 and 
click OK.

8. On the Manage window, click Close.

9. From the RDS Server - Console window, click Start, to start the RDS server.

10.When the Current Status on the RDS Server - Console window shows Started the server 
is running and configured properly. Now you are ready to Install the QuickBooks RDS Cli-
ent Application.
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Install the QuickBooks RDS Client Application

1. From the Start menu, select Programs > ALLDATA > ALLDATA Manage > Intuit RDS 
Client Install.
Result: A confirmation box is displayed.

2. Click Yes.
Result: The QuickBooks Remote Data Sharing Client - InstallShield Wizard window dis-
plays.

3. Click Next. 
Result: The QuickBooks Ready to Install the Program window displays.

4. Click Install.

5. When the InstallShield Wizard completes, click Finish. 
Result: The QuickBooks Remote Data Sharing Client - Setup window displays. 
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Setup the QuickBooks RDS Client Application

1. From the QuickBooks Remote Data Sharing Client – Setup window displays.

2. Click Find Server.
Result: The Server Discovery window displays.
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3. Select the server from the list and click OK. 
Result: The QuickBooks RDS Client – Setup window displays with the Server Name dis-
played.

4. Click OK. 
Result: The QuickBooks RDS Client - Console window displays. 
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Launching the RDS Server

Note: Always open the QuickBooks company file before launching the RDS server appli-
cation.

• After you have installed the RDS server software and completed the setup windows 
for the first time, the Install RDS Client and Install RDS Server buttons are dis-
abled.

 

• Select the Launch RDS Server on open option to automatically launch the RDS 
server when Manage is opened or use the RDS Server icon on the server PC desktop 
to launch the RDS server when required.

Note: Once installed the RDS application client does not need to be launched or config-
ured.



Accounting Integration with QuickBooks Installation and Setup Guide

Chapter 8: Additional QuickBooks Tasks 45

Chapter 8: Additional QuickBooks Tasks

Working with QuickBooks Accounts

If you change or delete accounts or items in QuickBooks that are referenced by Manage, the 
accounting integration can be negatively impacted. Use the Refresh QB Data button on the 
Accounting Setup window in Manage to refresh the information. If any of the accounts or 
items referenced by Manage are deleted, the Refresh QB Data button recreates them.

Only the accounts and items that Manage needs to be in QuickBooks appear in the Quick-
Books Accounts or QuickBooks Items grid on the Accounting Setup window. The Refresh QB 
Data button only updates the accounts used by Manage.

Viewing QuickBooks Tables Updated by Manage

Use the QuickBooks icons to quickly access information. The following are some of the more 
commonly used icons.

• Invoice

The most recent invoice is displayed. Use the options along the top to navigate through 
invoices. An invoice displays PAID in the header when it is paid in full.

• Cust

The customer list displays. All customers transferred from Manage after an order is 
posted or a refund is issued, are shown.

• Item

The line items are displayed for services and goods, and special items that perform calcu-
lations. Items, other than sales tax, should not be changed or deleted.

• Check

The Write Checks window displays allowing you to generate refund checks.

•  Reg

Warning: 
Changing company files in QuickBooks, when QuickBooks is 
integrated with Manage, can negatively impact Manage. If 
you have multiple businesses and need to access a differ-
ent company file make sure that Manage does not attempt 
to write to the company file.
Changing the tax items and accounts in QuickBooks that 
were created by Manage could prevent Manage from send-
ing updates to QuickBooks.

Warning:
The Tax Calculated on Invoices item CANNOT be recreated 
using the Refresh QB Data button. Do NOT rename or 
delete the Tax Calculated on Invoices item.
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The checking account register displays. Entries appear in the register for refunds created 
in Manage when the type is Check. You can actually print the checks using the Check but-
ton.

• Account

The chart of accounts displays all the accounts.
Double-click on an account to view all the entries for that account. Different accounts 
types display different fields, refer to the QuickBooks documentation or online help for 
more information.

Viewing QuickBooks Reports Updated by Manage

Use the Journal report to view all debits and credits. Select Reports > Accountant & Taxes > 
Journal to access the Journal report.

Assigning QuickBooks Accounts to Charges

The account assigned to a Job item is selected and displayed in the Account field on the Job 
Item windows in Manage.

To assign a QuickBooks account to a line item in Manage:

1. On a Job form, click Add.
Result: The Select New Job Items window is displayed with the Labor tab displayed.

2. Select the Part Items or Misc Items tab.

3. Select the appropriate account in the Account field.
Note: These accounts are the same QuickBooks Accounts created and listed on the 
Accounting Setup window.

4. Complete the appropriate fields and click Add.
Result: The item is added to the Selected Items grid.

5. When done adding line items, click Submit.
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Applying Payments in Manage

Notes: 
Deposits can be applied to repair orders, but repair orders must be converted to invoices 
before payments can be applied.
Do not forget to add Cost and Flagged Hours information for each line item on the 
invoice.

1. On the invoice or counter sale, click the Cashier… button.

Result: An Apply Payment window is displayed.

2. From the Payment Type drop-list, select Cash, Credit Card, Check, Debit, or Other.

3. Enter any options to go with the payment type (i.e. check number, authorization number, 
credit card type, expiration date, etc.)

4. From the Payment Date drop-calendar, select the date of payment. It defaults to the 
current date.

5. In the Payment Amount field, type the amount of the payment.
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6. Click to check Print Receipt to print a receipt.

7. Click the Apply button.
Result: The payment amount is reflected in the Amount Received and Balance Due 
fields.

8. If a balance remains, click the Close button when you are finished.
Result: The Apply Payment window is closed and a reminder message about posting the 
invoice is displayed.

9. When an invoice is fully paid, the Apply Payment window closes and the reminder mes-
sages for printing the receipt and posting the invoice are displayed. If you choose not to 
post the invoice, it will display on the Cashiered tab on the Work in Progress window.

Documenting Deposits

When you apply a deposit to a Repair Order in Manage, the information is sent as a Sales 
Receipt to QuickBooks. The journal entry credits your shop’s QuickBooks Customer Deposits 
account and debits the Undeposited Funds account by the amount of the deposit. Updated 
customer information is also sent to QuickBooks.
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Applying Deposits in Manage

1. On the repair order, click Take Deposit….
Result: An Apply Payment window is displayed.

2. From the Payment Type drop-list, select Cash, Credit Card, Check, Debit or Other.

3. Enter any options to go with the payment type (i.e. check number, authorization number, 
credit card type, expiration date, etc.)

4. From the Payment Date drop-calendar, select the date of payment. It defaults to the 
current date.

5. In the Payment field, type the amount of the deposit.

6. Select the Print Receipt option.

7. Click Apply, and then Yes.
Result: The deposit is reflected in the Amount Received and Balance Due fields.

8. Click Close when you are finished.

9. In QuickBooks, verify that the Journal Entries are updated in the Undeposited Funds and 
Deposits accounts to match payments made in Manage.
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Posting Invoices in Manage

When you post an invoice after a deposit has been applied, one of the journal entries sent to 
QuickBooks is a Customer Deposit debit to balance out the deposit. In the example below 
(Reports > Accounting and Taxes > Journal), 1 indicates the deposit and 2 indicates the 
Customer Deposit debit. 

To post an invoice or counter sale:

Invoices and Counter Sales should be cashiered before they are posted, otherwise the bal-
ance due will be applied to Accounts Receivable. Also, each line item should have actual costs 
information (Cost or Flg Hrs fields) entered before the invoice is posted.

1. Open an invoice or counter sale and click Cashier.

2. Add any outstanding payments to the invoice and click Apply.
Result: When the invoice is successfully cashiered a message displays prompting you to 
Post the invoice.
Note: When an invoice is fully paid, the Apply Payment window closes and the reminder 
messages for printing the receipt and posting the invoice are displayed.

3. After an invoice has been cashiered, click Post.
Result: If there are declined Jobs (check box cleared) on the order, a Save Recommen-
dation window displays allowing you to save the declined Jobs as recommendations for 
future orders.
In QuickBooks, verify that the Journal Entries are updated to match payments made in 
Manage.

Updating Accounts

After changing or deleting accounts in QuickBooks or adding or changing sales tax items, use 
the Refresh QB Data button on the Accounting Setup window to refresh the listed accounts.
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Updating QuickBooks Software

1. Select File > Update QuickBooks.
This will update the QuickBooks software without changing your company files, accounts 
or items.

Updating QuickBooks Preferences

You can use the Edit > Preferences option to customize the way QuickBooks works for you. 
The My Preferences tab can be used by all users to change the settings for the individual user 
and the Company Preferences tab can be used by the system administrator to adjust the set-
tings or all users.

1. From the QuickBooks menu, select Edit > Preferences....
Result: The Preferences window displays with the My Preferences tab selected.

2. In the toolbar on the left select the type of preferences that you want to update.

3. For example, select Desktop View.

4. In the Color Scheme drop-down list, select Sea Stone.
Result: The color scheme temporarily updates.

5. Click OK to save the changes.

6. From the QuickBooks menu, select Edit > Preferences....
Result: The Preferences window displays with the My Preferences tab selected.

7. Select the Company Preferences tab and then select Integrated Applications from 
the toolbar on the left.
Result: The Integrated Applications fields display on the Company Preferences window 
tab.

8. Select an application (for example: MANAGE) and make sure that it is checked in the 
Allow Access column.

Warning:

Changing these settings can negatively impact Manage. 

Warning:

Do NOT remove Manage or Service Center from the list 
and do NOT select the “Don’t allow any applications to 
access this company files” or Manage will not be able to 
access the company files. 
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9. Select an application and click Properties....

Result: The Properties - MANAGE dialog displays.

10.Select Allow this application to login automatically.

11.Click OK to save the changes.

12.Click OK to close the Preferences window.
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Chapter 9: Deactivating Accounting Integration
You can choose to deactivate accounting integration at anytime. 

Note: For assistance with deactivating Accounting Integration, contact ALLDATA Customer 
Support at 1-800-859-3282.

1. From the Setup shortcut bar in Manage, select Accounting Setup.
Result: The Accounting Setup window displays.
 

2. Clear the Integrate with QuickBooks box to turn off accounting integration.
Result: A message displays reminding you to backup your files before continuing.

3. Once the files have been backed up (refer to “Backing up QuickBooks and Manage” on 
page 71), click Yes to continue.
Result: A message displays stating that
“Your request will deactivate the QuickBooks integration.

Warning: 
To activate QuickBooks after it has been deactivated, you 
will need to create a new company files or use an unused 
(never integrated) company file.
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You will need to create a new service-based company in QuickBooks if you want to acti-
vate this integration again. Do you want to continue?”

4. Click Yes to continue the process.
Result: The following warning message displays:
“If you continue with the deactivation you will no longer be able to integrate with this 
QuickBooks company file. Do you want to continue?”

5. Click Yes to complete the process.
Result: When deactivation is complete, the Accounting Setup window closes.
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Appendix A: Transaction Mapping

Manage 
Transaction

QuickBooks Transaction
QuickBooks Account 

Credited
QuickBooks Account 

Debited

Update Cus-
tomer name, 
address or 
phone #

Customer table
(Changes to the customer 
name in QuickBooks will be 
reflected in the QuickBooks 
Name field of the customer 
record in Manage.)

n/a n/a

Integrate Opening balances are posted 
for credit balances as a Credit 
Memo.

Accounts Receivable Uncategorized Income

Total of all credit balances is 
posted as a General Journal 
entry to clear Uncategorized 
Income and move the total to 
Opening Bal Equity.

Uncategorized Income Opening Bal Equity

Opening balances for bal-
ances due on posted but 
unpaid Manage invoices are 
posted as a QuickBooks 
Invoice.

Uncategorized Income Accounts Receivable

Total of all balances due is 
posted as a General Journal 
entry to clear Uncategorized 
Income and to move the total 
to Opening Bal Equity.

Opening Bal Equity Uncategorized Income

Create order, 
save as esti-
mate, save as 
repair order.

none none none

Apply a deposit 
to repair order.

Sales Receipt entries for 
deposit amount.

Customer Deposits Undeposited Funds
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Post an invoice. Invoice created and invoice 
entries are posted.

A/R debited for total billed less 
discounts and deposits, (so 0 
if deposit paid it in full).

Accounts Receivable

All charges (at their pre-dis-
count rate) including taxes are 
credited to an income or liabil-
ity account.

• Parts Revenue 
(taxable)

• Parts Revenue 
(non-tax)

• Labor Revenue 
(taxable)

• Labor Revenue 
(non-tax)

• Sublet Revenue 
(taxable)

• Sublet Revenue 
(non-tax)

• Hazmat Revenue 
(taxable)

• Hazmat Revenue 
(non-tax)

• Shop supplies 
Revenue (tax

• Shop supplies 
Revenue (non-tax)

• Sales tax Payable

Discounts are debited to the 
proper account

Discount - Parts / Dis-
count Labor /Discount 
- Sublet (as applica-
ble)

Customer deposit balancing 
entry

Customer Deposits

Payment applied amount of 
payment is posted to A/R and 
Undeposited Funds, unless 
payment in full was made by 
an earlier deposit. Then noth-
ing.

Accounts Receivable Undeposited Funds

Manage 
Transaction

QuickBooks Transaction
QuickBooks Account 

Credited
QuickBooks Account 

Debited
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Refunds Check entries are posted for 
the refund

Order Refund from Service 
History tab

Selected bank account Returns & Allowances

Refund on an unposted RO 
that’s overpaid by deposits

Selected bank account Customer Deposits

Refund on an unposted 
Invoice that’s overpaid by 
deposits

Selected bank account Customer Deposits

Credit Refund from the Edit 
Customer > Payment Record 
tab:

• plus the original Credit 
Memo entry lines are 
reduced by the amount of 
the refund

• plus a General Journal 
entry so Opening Bal Equity 
and Uncategorized Income 
are in balance.

Selected bank account Opening Bal Equity

The original Credit 
Memo credit to 
Accounts Receivable is 
reduced

The original Credit 
Memo debit to Uncate-
gorized Income is 
reduced

Opening Bal Equity Uncategorized Income

Applied Credits No entries are posted for 
applying credits, but the 
Credit Memo is reduced.

--- ---

Credit applied when cashiering 
an invoice (not as a deposit on 
an RO), then invoice is posted.

Credit applied to a posted 
invoice on Payment Record 
tab.

Void a repair 
order that has a 
deposit and 
refund the 
deposit in the 
process

Check entries are posted for 
the refund in the deposit 
amount and reverse the 
deposit.

Selected bank account Customer Deposits

Convert an RO 
to an invoice, 
cashier and post 
it.

--- --- ---

Manage 
Transaction

QuickBooks Transaction
QuickBooks Account 

Credited
QuickBooks Account 

Debited
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Appendix B: Error Messages and Troubleshooting Procedures
The following procedures are provided to assist you in troubleshooting the more commonly 
encountered problems relating to QuickBooks.

Manage Error Messages 

If you receive an error message, locate the message in the following table to determine 
which procedure to use.

Message # Message Procedure

7002 QuickBooks is not running and must be to 
complete this action. MANAGE will start 
QuickBooks now. After QuickBooks opens, 
please try again.

Open QuickBooks and retry the 
action. 

 7003 The company file opened in QuickBooks does 
not match the one specified in MANAGE. 
Please open the matching file. 

QuickBooks is running, but the incorrect 
company file is opened in QuickBooks.

Please open the correct company in 
QuickBooks, or change the Quick-
Books Company File that you 
selected in the Accounting Setup 
window in Manage.

7004 There is no company file currently open in 
QuickBooks. Please open the correct com-
pany file. 

QuickBooks is running, but no company file 
is open. 

Please open the company file in 
QuickBooks.

7005 An open dialog box is showing in the Quick-
Books window. Please close the dialog box 
before continuing.

There is an open dialog box in Quick-
Books and Manage cannot access the 
QuickBooks database until the dialog 
has been closed.

Please switch to QuickBooks and 
close the dialog box.

7006 QuickBooks 2006 or higher is running in Sin-
gle-user mode and must be running in Multi-
user mode. Please switch to Multi-user mode 
in QuickBookss. 

In QuickBooks 2006, Manage is seen 
as a second user and requires multi-
user mode. 

Change to multi-user mode: 
1. Switch to the QuickBooks 

application.
2. From the File menu, select 

Switch to Multi-user 
mode.

3. Switch back to the Manage 
application and retry the 
transaction. 
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7007 The QuickBooks company file selected has 
previously been integrated with MANAGE and 
cannot be integrated again.
Please select a valid company file that has 
not been previously integrated with MAN-
AGE.

The QuickBooks company file 
requested has previously been used 
for integration and cannot be used 
again. You must either choose a dif-
ferent company file or create a new 
company file in QuickBooks and 
choose that file.

7008 Cannot find the QuickBooks directory. 

Please verify that QuickBooks is installed and 
configured properly before attempting to 
activate accounting integration in MANAGE.

Manage is looking for the Quick-
Books directory on the default drive 
(initially c:) and cannot find it. Verify 
that QuickBooks 2004 or later is 
installed or if QuickBooks is installed 
on another drive, use the Browse 
button to navigate to the drive and 
directory where the.QBW file is 
installed. When the Browse button is 
used to navigate to and select a dif-
ferent location the default drive is 
changed.

7010 The integration has been stopped and cannot 
proceed because the MANAGE database con-
tains at least one customer with both a credit 
balance and a balance due on posted 
invoices.
A Customer Balance Conflict report has been 
created and will display when you click OK.

Click OK to view the report.
If multiple customers are listed, print 
the report. Update the records for 
each customer listed, either to apply 
all outstanding credits or to cashier 
all posted but unpaid invoices. After 
resolving all of the balance conflicts, 
try integrating with QuickBooks 
again. Refer to MANAGE Help.

7011 This invoice cannot be written to QuickBooks 
because the “Tax Calculated On Invoice” 
item has been renamed or deleted. Please 
switch to QuickBooks and create or correct 
the Tax Calculated On Invoice item.

The Tax Calculated On Invoice 
item must be corrected in order to 
be able to post an invoice in Manage. 
This can be corrected by renaming 
the item to its original name or by 
creating a new Tax Calculated On 
Invoice sales tax item. 
Use the Item list in QuickBooks to 
edit or add the tax item.

7012 IMPORTANT: Before starting the accounting 
integration process verify that no Quick-
Books reports are open. When open, reports 
in QuickBooks can create errors and cause 
the integration to fail.

Close all reports in QuickBooks and 
click OK to continue with the 
accounting integration process. 

7013 The tax items have changed in QuickBooks.
You must choose a valid QB Parts Tax Item 
and a valid QB Labor Tax Item before closing 
the Accounting Setup window.

Refer to the MANAGE Help for the 
Accounting Setup window, select the 
correct QB Parts Tax Item and the 
QB Labor Tax Item in the two list 
boxes and click Submit.
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7014 Connecting to QuickBooks on the server has 
failed. Please correct the problem and try 
again.

1) On the Manage Server computer, 
verify that both the QuickBooks and 
the QB RDS server are running cor-
rectly.
2) Verify that the RDS server is cor-
rectly configured. Refer to the Quick-
Books Installation and Setup Guide 
for more information.
(See “Setting Up Networked Quick-
Books” on page 34.)

7015 MANAGE does not have permission to access 
the QuickBooks company file.
Please update QuickBooks to grant access 
permission through the Integrated Applica-
tion preferences.

Update the Company Preferences to 
deselect the Don’t allow any appli-
cations to access this company 
file option. For details, refer to 
“Updating QuickBooks Preferences” 
on page 51.

7016 MANAGE is running in Client mode and inte-
grated with QuickBooks. 
The QB Remote Data Sharing Client is either 
not installed or not configured correctly. 
Please install and configure the QB RDS Cli-
ent.

Reinstall the RDS client (refer to 
“Install the QuickBooks RDS Client 
Application” on page 41) on this 
computer. When configuring the 
QuickBooks RDS Client - Console 
window carefully verify your input.

7017 MANAGE could not access the QuickBooks 
Foundation Class (QBFC.dll) file.
The file is either missing or was not installed 
with sufficient user privileges.

Reinstall the Manage application 
(See “Setting Up Manage” on 
page 12) so that the library file is 
installed with the correct access lev-
els.

7018 The rate for a tax item being imported from 
QuickBooks is greater than 99.99%.
This item's rate will be set at 99.99% in 
MANAGE. Please correct the item's rate in 
QuickBooks and then refresh the QuickBooks 
data. Each tax rate must be less than 100% 
in QuickBooks when MANAGE is integrated.

Open QuickBooks and change the 
Sales Tax Item to 99.99% or below 
(“Setting Up QuickBooks” on 
page 14). Then, in Manage Refresh 
the QuickBooks data (Refer to 
Refreshing QB Data in the MANAGE 
Help).

7019 Cannot find the QuickBooks program file 
(QBW32.exe or QBLaunch.exe).

Please make sure QuickBooks is installed on 
the local computer before continuing in MAN-
AGE.

Reinstall QuickBooks (“To Setup the 
QuickBooks RDS Server Application” 
on page 38) before making any 
updates in Manage. This problem will 
impact posting invoices, issuing 
refunds, and refreshing the QB data.

7020 This invoice was successfully posted in MAN-
AGE, but writing the invoice to QuickBooks 
has failed.
Please check the QuickBooks company pref-
erences to ensure that charging sales tax is 
enabled before posting another invoice. You 
will need to manually enter this invoice into 
QuickBooks.

Update the charge sales tax option in 
QuickBooks, refer to “Verifying Tax 
Rate Settings in QuickBooks, non-
Canadian Versions” on page 68. 
Then manually enter the invoice 
information in QuickBooks.
Note: The invoice was already 
posted in Manage.
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7021 MANAGE failed to update this customer in 
QuickBooks.
Please switch to QuickBooks and make sure 
the Edit Customer window is closed before 
continuing.

Switch to QuickBooks and close the 
Edit Customer window. Switch back 
to Manage and click OK to continue. 

7022 The Accounts Receivable account in Quick-
Books cannot be accessed and this invoice 
cannot be written to QuickBooks. 
Please verify that the Account Receivable 
account is configured properly in QuickBooks 
and retry posting the invoice.

Refer to “Verifying Accounts Receiv-
able Account Configuration” on 
page 70.

7023 This payment cannot be written to Quick-
Books because the expected Accounts 
Receivable account has been renamed or 
does not exist. Please verify that the 
Accounts Receivable account is configured 
properly in QuickBooks.

“Verifying Accounts Receivable 
Account Configuration” on page 70.

7024 The Accounts Receivable account in Quick-
Books either has the incorrect name or does 
not exist.
Please switch to QuickBooks and add or 
update the Accounts Receivable account.

“Verifying Accounts Receivable 
Account Configuration” on page 70.

7025 Before integrating with QuickBooks, you 
must first enter a valid password.
Please contact customer support to receive 
the password.

Call customer support to receive the 
password. 

7026 The password entered is invalid. Please con-
tact customer support to receive the correct
password.

Either try re-entering the password 
or call customer support to get the 
correct password and then enter it.

7027 MANAGE is integrated with QuickBooks, but 
QuickBooks is not installed on this computer. 
Please disable the integration with Quick-
Books to avoid errors.

From the Setup menu, select 
Accounting Setup and clear the 
Integrate with QuickBooks check-
box. Click Yes on each of the confir-
mation messages to disable the 
integration. If you do not disable 
accounting integration, errors will 
occur when posting invoices, issuing 
refunds or entering deposits.

7028 This invoice was successfully posted in MAN-
AGE, but writing the invoice to QuickBooks 
has failed.
You will need to manually enter this invoice 
into QuickBooks.

Note the specifics of the invoice and 
manually update the invoice in 
QuickBooks. Refer to “Posting 
Invoices in Manage” on page 50.

7029 MANAGE failed to update this customer in 
QuickBooks.
Please contact customer support to resolve 
the problem.

Please note the specifics of the 
transaction and contact Customer 
Support for help resolving this issue.

8125 Invalid QuickBooks company file name. Click Browse and select a valid.QDW 
file.
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8128 The MANAGE parts and labor tax rates must 
match the QuickBooks sales tax rates.

The QuickBooks Sales Tax Items rate 
does not match the Manage tax rates 
for parts and labor. Either change the 
Manage tax rates to match the tax 
rate in QuickBooks or change the 
QuickBooks tax rates to match the 
Manage tax rates.

8145 The QuickBooks Installation and Setup Guide 
is missing.

Manage was unable to locate the 
QuickBooks Install and Setup.pdf 
file. It may have been accidentally 
deleted. You can re-install the miss-
ing PDF file by repairing your Man-
age installation.

8168 The QuickBooks RDS Client installer is miss-
ing.

Reinstall Manage to recover these 
files. 

8169 The QuickBooks RDS Server installer is miss-
ing.

Reinstall Manage to recover these 
files. 

8181 There are posted invoices with open bal-
ances due. All balances must be paid in full
before integrating with QuickBooks.

Manage has determined that at least 
one invoice has been posted with an 
outstanding balance. Integration 
cannot continue until the balance is 
cleared. When you click OK the inte-
gration process stops. 

To address the issue:
1. Print the Balances Due for All 
report to determine the invoices that 
have outstanding balances. 
2. Update the records to apply all 
outstanding credits or to cashier all 
posted but unpaid invoices. Refer to 
Applying payments to posted 
invoices and counter sales
for instructions. 
3. After resolving all of the balance 
conflicts, retry the Integrate with 
QuickBooks process. 

8183 MANAGE needs to open QuickBooks to 
access the customer file. When integrated 

with QuickBooks in MANAGE, the QuickBooks 
customer file needs to remain accessible.
Please do not close the customer file. 

To complete certain transactions 

when Manage is integrated with 
QuickBooks the customer file must 
be accessible in QuickBooks. To 
avoid problems do not close the cus-

tomer file while Manage is running.
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8188 This invoice cannot be written to QuickBooks 
because the Invoice Date is within the
period when the company books are closed.

Please switch to QuickBooks and change the 
Company Accounting Preferences setting
for Closing Date.

You are trying to post an invoice but 
your account in QuickBooks is in a 
closed period, that is, the closing 
date setting is today or in the future. 
Records cannot be written to closed 
periods in QuickBooks. Switch to 
QuickBooks and reopen your books 
by clearing the current closing date 
or setting it in the past.

This setting is accessed differently 
depending on the version of Quick-
Books being used. Refer to the 
QuickBooks Help system for details 
on reopening your books 

8199 The Sales Tax Items "Tax Calculated On 
Invoice", "Tax Calculated On Invoice (Pur-
chases)" and "Sales Tax" cannot be found in 
QuickBooks (Canadian Version).

Integration with the QuickBooks, 
Canadian version requires that the 
following Sales Tax items are config-
ured: 
•Tax Calculated On Invoice 
•Tax Calculated On Invoice (P)
•Sales Tax

Refer to “Add Sales Tax item for Pur-
chase.” on page 69.

8209 Activating the integration with QuickBooks 
can take up to several minutes depending on 
the speed of your computer.
Do you want to continue?

You have chosen to integrate Man-
age with QuickBooks. The activation 
process can take up to several min-
utes depending on the speed of your 
computer. You can confirm that you 
want to continue or cancel the pro-
cess. 

8210 Your request will deactivate the QuickBooks 
integration.
You will need to create a new service-based 
company in QuickBooks if you want to acti-
vate this integration again. Do you want to 
continue? 

This message displays when you 
deactivate the Account integration.
If you want to activate QuickBooks 
integration in the future, you will 
need to first create a new service-
based company file. Refer to “Setting 
Up the QuickBooks Company File 
using the EasyStep Interview” on 
page 14.

8212 All open counter sales, estimates, repair 
orders, and non-posted invoices will be 
recalculated with the new tax rate if you click 
Yes. 

You can save these changes by click-
ing Yes, or you can return to the 
Company Setup window without sav-
ing the changes by clicking No. 
If you click Yes, you should immedi-
ately update the QuickBooks tax 
rates. Refer to “Verifying Tax Rate 
Settings in QuickBooks, non-Cana-
dian Versions” on page 68.
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8215 All payments on Repair Orders and Invoices 
must be converted to customer credits 
before activating the accounting integration. 
Would you like MANAGE to convert the pay-
ments to credits?

Click Yes to automatically convert all 
payments made on open Rose and 
Invoices to credits.
Click No to stop the integration with 
accounting. You can then open the 
Work In Progress window, and final-
ize and post all orders that have pay-
ments made against them before 
restarting the integration process.

8216 This invoice has been cashiered and should 
be posted as soon as possible. Would you 
like to post it now?

Click Yes to automatically post the 
current invoice, or click No to return 
to the order without posting the 
invoice. You should post all invoices 
as soon as possible to prevent tax 
rate inconsistencies. Tax rate incon-
sistencies can arise if tax rates 
change between the time of the pay-
ment and the time of posting.

8222 MANAGE will now run the QuickBooks 
Remote Data Sharing Server installation. Do 
you want to continue?

Click Yes to start the server installa-
tion or click No to return to the 
Accounting Setup window.

8223 MANAGE will now run the QuickBooks 
Remote Data Sharing Client installation. Do 
you want to continue?

Click Yes to start the client installa-
tion or click No to return to the 
Accounting Setup window.

8224 Before deactivating the QuickBooks integra-

tion, you must back up your MANAGE data-
base and your QuickBooks company file.
This will allow you to restore your current 
settings should any problems occur during 
the deactivation process. Have you backed 
up these files?

This message displays when you 
deactivate the Account integration.
If the Manage database and the 
QuickBooks company file (.QBW) 
have been backed up, choose Yes to 
continue.
If the Manage database and the 
QuickBooks company file has not 
been backed up, click No and back 
the files up before deactivating the 
accounting integration. For more 
information, refer to “Backing up 
QuickBooks and Manage” on 
page 71.

8225 WARNING: If you continue with the deacti-
vation you will no longer be able to integrate 
with this QuickBooks company file. Do you 
want to continue?

This message displays when you 
deactivate the Account integration. 
Click Yes to continue deactivating 
the Accounting Integration. Click No 
to cancel deactivation of Account 
Integration.
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8230 MANAGE was unable to start QuickBooks. 
Refer to help for further instructions
on how to resolve this issue.

If you are running any of the Auto-
Zone supported Microsoft operating 
systems, the QuickBooks company 
file may have been moved. Use the 
Browse button (entering a password, 
if required) to locate the cor-
rect.QBW file.

If you are using Microsoft Vista on 
your computer and your QuickBooks 

database wasn't moved, Manage 
failed to start QuickBooks because of 
a security issue. With
the Vista operating system, the User 
Access Control must be enabled and 
both Manage and QuickBooks must 
use the standard-user access level. 

Verify that User Access Control is 
enabled by clicking Start > Control 
Panel > User Access and selecting 
the Turn User Access control on or 
off option. If you need assistance, 
consult the Vista Help system.

Once User Access Control is enabled, 
if you start QuickBooks or Manage 
without overriding the user access 
level, the application will start with a 
standard-user access level by 
default. For more information about 
User Access Levels refer to the Vista 
Help system. 

Warning: 
QuickBooks must be running and 
have the correct company file open 
when the Manage integration with 
QuickBooks is enabled and account 
information is being accessed.
If not, all payments and invoices that 
are processed will have to be entered 
manually into the QuickBooks sys-
tem.
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Troubleshooting Procedures

Verifying Tax Rates 

If you receive an error message stating that the tax rates must match, verify the tax values 
using the “Verifying Taxes in Manage” on page 67 and “Verifying Tax Rate Settings in Quick-
Books, non-Canadian Versions” on page 68 procedures to locate the problem.

Verifying Taxes in Manage 

The non-Canadian versions of QuickBooks require that the tax rates in Manage be set to 
match the QuickBooks settings. Use the “Use the Tax/Markups tab to view the tax rates applied to 
parts and labor items.” below.

Use the Tax/Markups tab to view the tax rates applied to parts and labor items.

1. From the Setup shortcut bar or menu select Company Setup.

2. Select the Tax/Markups tab.
Result: In the Tax Rates section, the name of the schedule currently set as the default is 
displayed in the Default Tax Schedule field. 

3. Use the Tax Matrix Setup button to open the Tax Rate Setup window, where you can 
verify tax rates and tax schedules and where you can select which schedule to use as a 
default Tax Schedule.
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4. Click Submit. 

Verifying Tax Rate Settings in QuickBooks, non-Canadian Versions

Tax rate information is stored in the items list. When you created the Company File (refer to 
“Setting Up the QuickBooks Company File using the EasyStep Interview” on page 14), Quick-
Books created at least one item of the type Sales Tax Item with the name Out of State. If 
you created Parts and Labor tax items to use with Manage, they are also listed in the Items 
List. 

1. From the QuickBooks menu, select Item.

2. Verify that the default sales tax items are listed.
Note: If the tax rate items are not listed, refer to “Updating QuickBooks Preferences” on 
page 51, in the QuickBooks Manual or the QuickBooks online help for information on set-
ting up sales tax.

3. Note the tax rate in the Price column for the sales tax items.

4. Verify that the names and tax rates in the QuickBooks item list match the settings in the 
QB Parts Tax Item and QB Labor Tax Item fields on the MANAGE Accounting Setup 
window.

5. Verify that the names and tax rates in the QuickBooks item list match the Parts% and 
Labor% fields in the Tax Rates section of the Tax/Markups tab of the Company Setup 
window in Manage.

Use the MANAGE Accounting Setup window to determine the QuickBooks tax items 
applied to parts and labor items when entering accounting information.

1. From the Setup shortcut bar in Manage, select Accounting Setup.
Result: The Accounting Setup window displays.

2. Verify that the name in the QB Parts Tax Item field is the same sales tax item name 
entered in QuickBooks when creating the company file.

3. Verify that the name in the QB Labor Tax Item field is the same sales tax item name 
entered in QuickBooks when creating the company file.

Verifying Tax rate settings in QuickBooks, Canadian Version 

The Canadian Version of QuickBooks does not require compatibility with the tax settings in 
Manage but instead requires that additional Tax Rate settings be configured prior to integra-
tion with Manage. 
If you will NOT be using the Canadian version of QuickBooks you can skip this procedure and 
refer to the procedure in “Setting Up Manage prior to Accounting Integration” on page 12. 

The two Tax Codes required in QuickBooks, Canada for use with Manage will need two Sales 
tax items for each Tax Code.



Accounting Integration with QuickBooks Installation and Setup Guide

Appendix B: Error Messages and Troubleshooting Procedures 69

Add Sales Tax item for Purchase.

1. From the List menu click Item List.

2. Scroll to the item named Tax Calculated On Invoice.

3. Click Item and Edit Item.
Result: The Edit Item window displays.

4. Verify the following settings:

5. Click OK. 

1. From the List menu click Item List.

2. Scroll to the item named Tax Calculated On Invoice (P).

3. Click Item and Edit Item.
Result: The Edit Item window displays.

4. Verify the following settings:

5. Click OK. 

1. From the List menu click Item List.

Field Input

Sales Tax Name Tax Calculated On Invoice

Description Tax Calculated On Invoice

Tax Rate (%) or Am  any value

Tax Agency Receiver General 

Sales Tax Return Line
Line 103 GST/HST collected or 
collectible

Field Input

Sales Tax Name Tax Calculated On Invoice (P)

Description 
Tax Calculated On Invoice (Pur-
chase)

Tax Rate (%) or Am any value

Tax Agency Receiver General 

Sales Tax Return Line Line 106 Input tax credits (Its) 
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2. Scroll to the item named Sales Tax.

3. Click Item and Edit Item.
Result: The Edit Item window displays.

4. Verify the following settings:

5. Click OK. 

Verifying Accounts Receivable Account Configuration

If you receive an error message instructing you to “verify that the Accounts Receivable 
account is configured properly in QuickBooks” use this procedure.

1. Switch to or open QuickBooks.

2. Select Hadn't from the toolbar.

3. Verify that the spelling and capitalization is an exact match.

4. If the spelling or capitalization is incorrect, edit the account to fix the problem.

5. Search the list to locate Accounts Receivable and verify that the type is Accounts Receiv-
able.

6. If the type is wrong either delete the account or rename it and create the account with 
the correct name and type. Refer to the QuickBooks online help for information about 
deleting or renaming accounts.

7. After verifying the account or making updates in QuickBooks, switch to Manage and 
select Refresh QB Data button on the Accounting Setup window.

Result: This will update the QuickBooks accounts and items in Manage.

Field Input

Sales Tax Name Sales Tax

Description Sales Tax

Tax Rate (%) or Am 0.00%

Tax Agency Receiver General 

Sales Tax Return Line
Line 103 GST/HST collected or 
collectible
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Backing up QuickBooks and Manage

When you have active databases or company files before integrating QuickBooks with Man-
age you should backup your databases and company files before and after integration.
Each time you backup files and databases you should name the backup files with a descrip-
tive name. For example: ABCco_b4int080805.qbw and ABCco_af_int080805.qbw and 
ABCco_pre080805.scb and ABCco_post080805.scb.
Note: Do not attempt to restore a backup file from a previous version of QuickBooks. When 
upgrading QuickBooks, back up the company file in the old version, upgrade to the new ver-
sion and allow the new version to update the company file itself, then create a new backup in 
the new version.

QuickBooks Backups

1. Open QuickBooks.

2. From the File menu, select Back Up.

3. From the QuickBooks Backup dialog box, enter a descriptive name in the filename field.

4. Select Disk and enter or select a directory location to use for storing the backup files.

5. Click OK.
Result: The current database is saved to the file in the selected location. QuickBooks 
presents a confirmation message when the backup is complete.

Manage Backups 

To manually back up your Manage data:

1. Open Manage.

2. From the File menu, select Backup.

3. In the Save As dialog box, browse and select a directory to use for storing the backup 
files.

4. Enter a descriptive name in the file name field.

5. Click Save.

Result: The current database is saved to the file in the selected location. Manage presents 
a confirmation message when the backup is complete.

QuickBooks Restores

1. Open QuickBooks.

2. From the File menu, select Restore.
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3. In the Get Company Backup from: section, select Disk and verify or enter the name of 
the appropriate backup file in the Filename field.

4. Enter or select a directory location where the backup file is located in the Location field.

5. In the Restore Company Backup To: section, enter a target filename to use for the 
restored company file.

6. Select the target location of the newly restored company file.

7. Click Restore.
Result: The current database is closed and the restored database is copied to the target 
file in the target location and opened.
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